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Introduction

If you ever wish there were more than 24 hours in a day, rest assured that you’re not
alone. Most of us are running at warp speed while trying to juggle the demands of work and
family. We live in an age where dual income families and single parent homes are more
common than the deliriously happy single income sitcom families we grew up watching on

television- a standard we should all just try to forget.

It’s no longer realistic to seek perfection in life. If you strive to keep a perfect home, work
full time, commute, put a fresh, hot dinner on the table and spend quality time with your
family every day, you are likely to spontaneously combust. If there is one thing that can be
learned from quality time management, it is that you need to let some things go. So your
house isn’t always dust free and your recycling bin is overflowing; will the earth stop its
rotation because of it? In the grand scheme of things, does a perfect home really equal a
perfect life? As long as you are making time for what is really important in your life- and

you will define those things after reading this book- then you can consider yourself a success.

We must work to live, not live to work and we owe it to ourselves to appreciate what it is we
work so hard for. Your big house with the three car garage may seem like a haven to an
outsider, but if you have to work 80 hours each week to afford it and end up missing out on

quality time with your family- and yourself- is it really worth it?

Do you know someone who is constantly on the go yet they somehow manage to accomplish
an incredible number of tasks each day and make it look effortless? Do you ache to find
more hours in the day? The good news is that you can make better use of your time and

become more productive by simply modifying some of your behaviors.

You are about to read over 100 ideas for managing your time. By integrating even just a few
of these ideas into your daily routine, you should see results right away. Just remember to

pace yourself. Don’t view this as another checklist of things you must do, but begin to
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incorporate the ideas that fit your lifestyle the best. Make it fun. Try the suggestions and see
how they work for you. Then modify them to fit your needs and reap the rewards of your
newly organized lifestyle. And remember that those television sitcoms are fiction. None of
us really live a perfect existence and striving for that image will do nothing but leave you

feeling deflated and even more frustrated at the end of the day.

You might want to keep a highlighter handy while you read through the suggestions in this
book. Use it to manage your reading time and keep track of the tips that you want to start

using right away.
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1)

2)

3)

Office Time Savers

Turn your email off. It may be hard to break away from your constant
communication with the world, but if you check email twice per day instead, you will be
amazed by how much time you save. Specify specific time frames during the day that

you will devote to email and stick to your schedule.

One Silicon Valley company recently implemented a No Email rule on Fridays. If you
need a question answered, you have to pick up the phone or walk over to the person with
the answer. While this may not always be the most productive solution, it drives home
the point that we rely too heavily on email for our communication. When you stop

letting it rule your life, your productivity will ultimately increase.

Delete all junk messages and anything you don’t need to read again- and do it
immediately. Avoid just clicking around the junk in your inbox and instead get rid of it

when it arrives.

Create email filters to send junk mail directly to the trash bin. With the latest
version of Microsoft Outlook, you can right click on a junk message and add the sender
to your Blocked Senders list, preventing any future messages from that sender from

landing in your Inbox.

4) Create folders to sort and organize your email messages. Make a list of the
folders that will help you get organized and sort your mail to the appropriate folder every
day. If you are using Microsoft Outlook, here’s how:

e Click on View > Folder List to display your email folder list on the left side of
your screen.
e Click on Inbox in the folder list, then go to the menu at the top and select File >
New > Folder
e Give the folder a name and press Enter.
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e Now you can drag and drop email messages to that folder. Repeat steps to create

as many folders as you need to get organized.

5) Create special folders to automatically sort incoming mail. For example, all
messages from your best client should be routed to your Priority folder. Then when you

check your email, you know to check that folder first. For Microsoft Outlook:
e Create a special mail folder, for example, “Priority”.

e Right click on an existing message from the selected individual to display a menu

of options.
e Select Create Rule.

e Choose the appropriate options in the dialog box to route the messages to your

selected folder.

6) Get caller ID. How much time do you spend each day answering calls that aren’t
urgent? Let caller ID help you decide when to answer your phone. Don’t recognize the
number? Send it to voice mail. Is it a friend who will keep you on the phone for 30

minutes? Send it to voice mail.

7) Better yet, let all of your calls go to voice mail and return them when it is
convenient for you. Do you drop everything when the phone rings? How often is it
really critical that you answer the phone? By sending your calls to voice mail, you allow
yourself time to prepare your responses to important questions. The fact is that if it’s

important, the caller will leave a message.

8) Set up special ring tones on your phone. Most of the newer model phones allow
you to set a different ring tone for phone numbers in your speed dial directory. You can
use this to help you recognize when your spouse, child, boss or best client is calling. This

is a great system for both at home and at the office.
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9) Return calls from your car. Use your cell phone- with the headset- to return calls
while you’re driving home, sitting in traffic or on your way to a meeting. Not only is this
a good use of commute time, but it sets a finite amount of time that you are available to
talk.

10) Reduce office chat. How much time is wasted each day by gossiping with your
neighbor or chatting about the latest reality show du jour? Friendly conversation can be
nice but it’s also a distraction that adds up when you stop for 5 minutes here and 10
minutes there. You can politely cut a conversation short by saying with a smile, “I have

to get back to work if I ever want to make it home for dinner tonight!”

11) Minimize subscriptions to mailing lists, groups and organizations. It’s easy to let
subscriptions add up and then you later discover that you don’t really need that daily
digest of recipes, baseball scores or business news. Take a moment to unsubscribe from
lists that don’t offer you any value and just suck up valuable time. You could also use
email filters to route some of these subscriptions to a special folder to read when you

have some free time.

12) Take an inventory of where you time is going. Spend a few days jotting down
how you spend your time throughout each day- 40 minutes on email, 25 minutes chatting
with a coworker, 30 minutes for lunch, 2 hours fixing a problem, another 45 minutes with

email, etc. This should paint a picture of where you are losing valuable time in the day.

13) Don’t accept projects that don’t get you toward your ultimate goals. It may
sound like fun to organize birthday lunches or office parties, but if it takes up time that
you don’t have to spare, let someone else organize Bob’s birthday extravaganza. Learn
how to say “No” or, “I’m just too busy right now. Can you ask Janet to handle that?”

14) Clear the clutter from your desk. When your workspace is disorganized it can
cause you to feel overwhelmed before your day has even begun. You also shouldn’t have
to search for the documents you need or the report you started working on a few days ago
that is now buried under three other projects. Use file folders and a desktop organizer to
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keep projects separate and easy to access. An organized workspace will free up your
mind and your time.

15) Print the filename and path on your documents so that they are easy to locate
later. If you generate a lot of documents and often find it difficult to refer back to them
later, adding a file name to the bottom of each document could save you time later. To
do this with Microsoft Word:

¢ From the menu, select View > Header and Footer
¢ Click in the footer area and select Insert Auto Text
¢ Select Filename and Path

16) Use the Search function to quickly locate files on your computer. If you need to
locate a file but can’t recall exactly where it’s stored or its exact name, instead of

desperately searching through folders, run a search to locate it quickly. To do this with
Microsoft XP:

¢ Click Start > Search > Files or Folders

¢ Select Documents

¢ Type in a key word from your document title and click Search. The system will
generate a list of documents that match your keyword. Double click on any of the

documents to open.

17) Stop blogging! Online blogs are essentially journals about everything from news
and sports to fashion and humor, and the popularity of these diaries continues to grow.
Whether you are reading or writing blogs each day, consider if it’s really worth your

time. If you still need your daily fix, then allot a small amount of time in your schedule
and stick to it.
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18) Get rid of your instant messenger. Instant messages allow you to communicate
with online buddies or coworkers quickly. The pop up windows interrupt whatever
you’re working on and they are difficult to ignore. Some companies have employees use
these for communication, but in most cases, they become another form of office chatter
and end up reducing productivity instead of increasing it. If you must use an instant
messenger, designate a time during the day, perhaps while you are checking email, to

turn it on.

19) Hide out. If constant interruptions are sabotaging your productivity, find another
location to work. If you’re in an office, try a conference room. If you’re at home, lock
the door or go to the library, just do what you can to avoid the aggravation and the hassle

of interruptions.

20) Make use of travel time. If you have to travel, the long hours at the airport and on
the plane create a lot of time to either catch up on tasks or schedule time for yourself to
read for pleasure. Just as you plan what you need to pack, plan on how you will use this
time. If you need to work on a presentation, make sure to bring a back up battery for
your laptop. If you want to catch up on some reports, pack them in your carry-on bag
along with highlighters or other implements you need to make the time productive. Do
you just want to read and relax? Make sure to bring enough reading material to last the
duration. Traveling can be unpredictable and you could find yourself on a layover or
stuck for hours longer than anticipated. Make sure you have a plan to make use of this

time and your travel experience will be much more pleasurable.

21) Hire a Virtual Assistant to handle administrative tasks. VAs are remote office
administrators who can handle tasks including large mailings, contact management and
other office duties. They can be hired for a simple project or on an ongoing basis. To
find a VA, visit http://www.IVAA.org.

22) Manage interruptions from coworkers. If other people in your office demand
much of your time each day, set specific time for meetings with employees or coworkers

100+ Time Management Tips for Busy Professionals Page: 9
By Stephanie Chandler www.BusinessinfoGuide.com




and publish this schedule, then have them sign up for a meeting time. This lets everyone
know that your time is valuable yet you are still available.

23) Use a working lunch wisely. It’s easy to work through lunch, but instead of
skipping lunch altogether, make this a productive time by scheduling meetings with
employees or clients along with a meal. You can easily order in sandwiches for a
working lunch or treat a client to lunch and add valuable “face time” with your important

customers.

24) Make everyone more efficient. You’re probably not the only one in your office
struggling to make the most of your time. Get your colleagues together to brain storm
how you can all work more efficiently. Putting several heads together could yield some

fantastic results.

25) Manage your contacts. If you maintain a large list of people in your network, use
contact management software or the contact management provided by Microsoft Outlook
to create mailing lists, remember important birthdays or make notes about your

interactions with clients to remember when you meet with them next time.

26) Define your overall objectives for your work. Is it to work on tasks that generate
revenue? Then face each new task and decide whether it is going to get you closer to
your goal. If not, determine if you can hand it over to someone else or skip it altogether.

27) Praise the people around you for a job well done to encourage efficiency. You
will benefit even more if your family and coworkers also learn to better manage their
time. Recognizing these efforts creates positive reinforcement that everyone can

appreciate.

28) Get in the habit of using a To Do list every day. At the end of each day, make a
list of items to complete the following day. This helps you put closure on the day so you

don’t leave worried about forgetting the tasks that await you tomorrow.
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29) Prioritize your To Do items. Get the urgent tasks and items you dread done first so
you can breeze through the rest of the day. Be sure to cross them off as you complete
them. Not only does this help paint a picture of you how much you have left to finish in

a day, but it also gives you a sense of accomplishment.

30) Devise a system to evaluate the urgency of tasks. Many people find it difficult to
prioritize tasks and end up struggling needlessly to complete projects in a timely manner.
If you have many tasks to complete each day and need help evaluating their importance,

devise your own system for prioritizing your work. For example:

e Priority 1 - Tasks that must be completed in a matter of hours.

Priority 2 - Tasks that need to be completed by end of day

Priority 3 - Tasks that need to be completed the following day.

Priority 4 - Tasks that need to be completed by the end of the week.

Priority 5 — Tasks that aren’t urgent but should be completed eventually.

Develop a similar system like the one shown above and assign your priorities each
day to your To Do list.

31) Capitalize on your energy levels. When do you have the most energy? In the
morning, after lunch or late afternoon? Identify when you are most productive and tackle

your biggest and most important projects when your energy is in high-gear.

32) Keep snacks handy. Do you suffer from the mid-afternoon groggies? Instead of
downing another cup of java, reach for a pack of peanuts, a granola bar or a piece of fruit.
Not only will a small and healthy snack kick your metabolism into gear, it will boost your

energy until dinner time.

33) Avoid juggling multiple projects at once. While multi-tasking can be effective in

certain situations, don’t try to multi-task on several tasks at once. Stopping and starting
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several different projects causes you to lose focus and makes your day feel more chaotic.
Get to a point where you are officially finished with one task before you move on to the

next.

34) Manage your meetings. Set expectations when beginning a meeting by announcing
a cut-off time. You could say something like, “I know you’re busy too and | have
another meeting at 3:00 so let’s plan to wrap this up by 2:45.” This not only keeps your
schedule on track, but busy attendees will appreciate it as well. Keep an eye on the clock

and stick to the time you have allotted.

35) Make your meetings more efficient. Hold effective meetings by setting an agenda
and sticking to it. If you can’t come up with an agenda, then you probably don’t have a

reason to hold a meeting.

36) Keep your meetings small. Limit the number of attendees at a meeting to minimize

the excess discussion time.

37) Get some training. If you are struggling to use a software program or tool that you
don’t understand and you’re spending too much time fighting with it, take time out for
training. If you can’t make time for an actual class, take the online tutorial or read the
online Help guide or the product manual. If that doesn’t work, consider scheduling some
time with a coworker who is an expert. The frustration of struggling with an application
can ruin your day and take time away from other demands. Find a way to solve the

problem swiftly.

38) Stop repeating yourself. Do you spend too much time training other people or
explaining processes? It’s probably time for a training manual or procedures manual.
Delegate this task if you can, or invest your own time to create this valuable resource that
can be used over and over again. It may be an initial investment in time, but could save
you time and headaches in the long run. Procedures manuals are also appreciated by

workers who can refer to them when needed, allowing them to be more self-sufficient.
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39) Never leave your desk empty handed. Need to drop off items in the mail bin? Or
put something away? Grab the items on your way out to a meeting or lunch and drop
them where they need to go. Get in the habit of keeping things moving whenever you

need to leave your desk.

40) Make the most of conference calls. If you can’t avoid conference calls where there
is little need for your participation, mute the phone and get to work on some light filing

or something that allows you to keep one ear on what’s being said.

41) Make an outline for your presentations or big projects. We are taught in grade
school to use an outline to organize our thoughts when writing a paper. While it may
seem like an extra step that will require even more time, creating an outline gives your
project some direction and should actually minimize the amount of time you struggle

with developing the entire project.

42) Use Post-it notes to organize your thoughts. If you are struggling to organize an
outline in proper order, write each topic heading on a Post-it note and spread the notes
out on a big white board. Move the topics around until you find the right flow. These
sticky little wonders can help get your project on track, freeing up time to develop the

project effortlessly.

43) Evaluate your routine. Do you spend the day jumping from task to task? Group

tasks together. Set a time to file, organize, return phone calls, etc.

44) Use stacking files to organize your projects. Create an inbox, an outbox and use

extra boxes to sort out specific projects.

45) Get your filing system in order. Do you waste time looking for invoices or
receipts? Create a file folder for receipts each month and simply drop your papers into
each corresponding folder. This can also be useful later on when you have a question
about a credit card expense from January. Simply pull out your January folder and voila-

you have your information at your fingertips!
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46) Use pre-printed lists for supplies, groceries, etc. Make a list of the office supplies
that you use regularly and post one on a bulletin board near your desk. Simply check off
the supplies you need when you run low so you remember what you need to reorder.
This system works well for groceries and household supplies too. Get your family in the
habit of checking off items that are running low so you never again forget to pick
something up at the grocery store.

47) Minimize trips to the office supply store by having your orders delivered. Most
orders of $50 or more will be shipped in 24 hours for free. What if you don’t need $50
worth of supplies? Check your stock of expensive items such as printer cartridges, blank
CDs or copy paper. Will you need to reorder any of these items soon? Add them to your

list now to save on the shipping fee.

48) Catch up on paperwork while watching TV at night. You can enjoy time with
your family or catch the evening news while sorting or reading through paperwork during
commercials. Use this time to pay bills, sign homework forms or attend to business

matters.

49) Hire someone to do it for you. How much is your time worth? Do you make $20,
$50 or $100 per hour? Consider hiring someone who costs less per hour to handle the
chores that are consuming your time. You can hire a house or office cleaner, an assistant

to handle paperwork, a student to make calls, a website designer, etc.

One New York based Bed and Breakfast was featured on the TLC channel’s popular
show “Taking Care of Business.” The owner was practically a one woman show. She
answered the phones, took reservations, checked in guests, cleaned the rooms, did the
laundry and by the end of the day, she was completely wiped out. Though money was
tight and her business was struggling, she was advised to hire help, freeing up her time to

focus on running and marketing her business.

She ultimately hired a cleaning service to maintain the rooms and now sends the laundry
out. Though it was an expensive investment, it ultimately made her business more

productive because the owner had more time and energy to focus on revenue generating
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tasks. The end result? Occupancy rates have since increased rapidly and the fate of the
business looks hopeful for the first time in four years. It may be difficult to consider
investing in help, but if done the right way, that help could ultimately result in added
profits.

50) Use the barter system. If you can’t afford to hire someone to help out, consider
bartering or trading services. You could offer a website designer some free products or
services in exchange for design services or trade babysitting duties with a trust worthy

neighbor.

51) Manage your calendar. Get in the habit of using the Calendar function offered by
Microsoft Outlook. The calendar not only allows you to manage your appointments, but
will send you reminders for appointments, birthdays, etc. You can even use it to remind
yourself of regular tasks such as watering the plants, backing up your computer or taking

out the trash.

52) Avoid being a perfectionist. There are certain projects that require extra effort such
as a presentation for a customer or the boss. But if you’re pressed for time, some projects
can be done to the best of your ability without fretting over the details. Remember your

priorities and if this project isn’t high on the list, just do your best and let it go.

53) Delegate tasks. Tackle a big project by breaking it down into small pieces then
outline a plan and delegate tasks whenever possible. Also evaluate any tasks that you

currently handle that you could hand off elsewhere and get them off of your To Do list.

54) Get organized. Use baskets or plastic bins to organize office supplies, stray
business cards, pens, and anything that is causing clutter or reducing your productivity.
Professional organizers advise that you need to make sure everything has a place.
Designate a place for all your office clutter and make it easy to put it away and find it

when you need it.

55) Negotiate deadlines when feasible. We often place urgency on tasks when it may
not be necessary. If your boss asks for a report by the end of the day but your schedule is
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full, explain the situation and request a later due date. You might just break your bosses
habit of making everything he asks a priority. Your boss isn’t the only one to consider
here. Do you rush everything for your clients? Why not ask if you can get back to them
by Friday instead of the same day? Your client may not be in any hurry at all and the

worst part will be that you will discover you’ve put a rush on everything for too long.

56) Evaluate all the tasks you complete each day and ask yourself why? Is every
single report or task really important or is it simply something that you have done for a
long time but may no longer be necessary? Does anyone actually read your daily report

or could you instead produce a weekly or monthly version? Question all tasks.

57) Don’t get sidetracked by tasks that come up throughout the day. Instead of
dropping what you’re already working on, add the new task to your To Do list and finish
what you started. It’s easy to shift gears and drop everything, but remember your
priorities and try not to move to another task until you’ve completed the one you’ve
started.

58) Use templates for repeat projects. Do you have a daily, weekly or monthly report
to write? Do you spend time calculating figures manually that could be done easily in a

spreadsheet? Create templates to reuse over and over again and minimize your prep time.
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Family Time Savers

59) Double up on dinner. Has dinner time become another frustration for you?
Whenever you make a meal, double the recipe and freeze half of it for a quick meal the

following week.

60) Freeze leftovers. If you have a serving or two left of tonight’s dinner and you know
nobody will want it tomorrow, put it in a freezer safe container and save it for lunch or a

quick dinner option in the upcoming weeks.

61) Establish quick dinner solutions. Keep quick and healthy meal choices on hand
for those nights when cooking seems out of the question. Try soups, salads, frozen
dinners, sandwich fixings, meat for the grill and jars of pasta sauce. When you make
garlic bread, freeze the leftovers and pull out a few slices as needed, broil for a few

minutes and serve along side some pasta or barbecued meat.

62) Multi-task when you are on the phone at home. Have a weekly gab session with
your mother? Do you spend an hour catching up with your best pal or sister? Fold

laundry, dust or straighten up the kitchen while you chat.

63) Invest in an inexpensive head set for your home phone. Most of us own a
cordless phone by now and most of these can be clipped on to your belt with a $10
headset plugged in for hands free talk time. This makes it easy to multi-task while

talking.

64) Designate a daily chore to everyone in your family. In previous generations, most
kids worked for a living! Break your kids away from the video games for twenty minutes
to help with garbage duty, dishes, vacuuming or taking care of the pets. Delegating one
chore to everyone daily will lighten your load and keep your home organized and clean.
You can even make a list or spreadsheet and rotate the chores or make it fun by offering a

reward after everyone finishes.
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65) Get your house in order. If you have items in your house that are in a constant
state of chaos, spend a day to get organized. Designate a box for gift wrapping supplies,
another container for spare batteries, another for nails and tacks, and so on. Give your
kids bins for toys, shelves for books and use inexpensive closet organizers to keep
everything neat and accessible. Drawer organizers can make even the chaotic kitchen
drawer neat and tidy.

66) Set up mailboxes in your house for each person. When you bring in the mail, sort

it immediately into each person’s designated basket or container.

67) Manage annual appointments. Set reminders in your calendar to schedule doctor
and dentist visits for you and your family. Map out your schedule early in the year so
you’ll be sure to make all of your important visits. Don’t forget to include your trip to

the optometrist if you wear glasses and your insurance allows for a “free” pair each year.

68) Manage your snail mail. Put your incoming mail at home and at work in a basket
and check it every few days. Most mail doesn’t need to be opened immediately. Throw

away all junk mail as soon as it arrives.

69) Write it down. Keep a small spiral notebook and pen in your car, briefcase or purse.
Divide it into sections to keep lists of things you need to do for home, for work, and for
the kids. When you think of a task or item you need to pick up, jot it down immediately.
Get in the habit of using your notebook to keep yourself organized. Writing things down

also gets them off your mind, freeing up your thought for more relaxing pursuits.

70) Have your kids read to you in the car. As parents, we know the importance of
reading and helping our kids develop this valuable skill. Even if your drive to school
only takes ten minutes, you can make those ten minutes count by asking your child to
read a chapter or a short book. This adds quality to your time together and can be a fun
way to help develop your child’s reading skills. If you have multiple kids, let them take
turns each day. Soon it will become a game and they will look forward to their turn to

read.
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71) Get it delivered. All kinds of stores now deliver for free or a minimal fee. Check
out http://www.Safeway.com to save time at the grocery store. Costco offers delivery to

many business locations: http://www.Costco.com.

72) Hire a Pet Sitter. Pet sitting services are popping up everywhere and aside from
providing a great alternative to boarding your pets while you travel, most sitters can also
take your furry family members to Veterinarian visits or grooming appointments and will
even walk your dog. Visit Pet Sitters International to find one in your area:

http://www.petsit.com/.
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Personal Time Savers

73) Go to the bank from the comfort of your home. Use online banking to manage
your money and pay your bills. It takes a little time to set up initially, but you will never
again have to sit down with a giant stack of bills. Online banking makes it easy to
manage your budget and balance your checkbook and most banks offer this service free

of charge.

74) Don’t let magazines pile up. As soon as you finish reading your favorite monthly

glossy, put it in the recycle bin or in a bag to donate to the hospital or senior center.

75) Touch everything only once. Avoid saving for later what you can sort, throw away
or put away now. If you make a lot of piles at home and work, then you are already
saving too many things for later. If you have to, schedule time in your day to deal with

your piles!

76) Leave yourself reminders. Do you tend to forget items as you leave the house in
the morning? Place a Post-it note on your front door with reminders to yourself or your
family. If there are items that you need to take with you in the morning, such as a
briefcase, book or outgoing mail, get in the habit of setting items by the front door at
night to avoid the frantic gathering in the morning.

77) Use an organizer. Franklin Covey has cornered the market with their time
management systems in the form of day planners. Consider getting a day planner, or if
you are electronically inclined, a hand held organizer. The key to success with these
tools is to use them consistently. Organizers give you a central point to manage your
calendar, addresses, To Do lists, track expenses and keep other tasks neatly organized.
Most electronic organizers can also be synched up with the contacts and calendar on your

computer so everything is kept up to date and only needs to be entered once.

78) Manage your wardrobe. Do you spend too much time picking out something to
wear in the morning? Organize your closet to increase your sanity. Anything you

haven’t worn for a year or more should be donated to charity. Put items you wear most

100+ Time Management Tips for Busy Professionals Page: 20
By Stephanie Chandler www.BusinessinfoGuide.com




frequently in the front of your closet. Organize the rest of the items by separating tops
and bottoms and then arrange by color.

79) Get rid of it. After you clean out your closet, tackle the rest of your house. Box up
old toys, unused gifts, and knick knacks that are taking up space and cluttering your life.

Call your favorite local charity to arrange for a curb-side pick up of your donation items.

80) Decide on your weekly wardrobe. Minimize the morning chaos by having your
wardrobe ready to go. On Sunday night, select five outfits for the week and move them

to the front of your closet for quick access.

81) Find your keys. Always losing your keys? Designate a bowl or shelf where you
place them both at home and at the office.

82) Visit the dry cleaners. Spending too much time ironing? If you’re spending an
hour a week or more and resenting your ironing board, send it out. Your local cleaners
will be happy to have your business and you’ll be relieved to tuck that ironing board back
into the closet.

83) Get paid in time. Instead of asking for a raise, how about asking for more vacation
time or a flexible work schedule? Companies that are strapped for cash or bosses that
understand the importance of family could be open to rewarding your hard work with
time instead of cash.

84) Take a mental health day. When you’ve been working hard and need a break, take
one. Reward yourself with a day to sleep in, read a book, get a massage or just relax in
the backyard. Everyone deserves some down time and your body will appreciate a break

from stress.

85) Put off committing to an event until you’ve had time to think it through. How
often are you asked to attend a party by an acquaintance or you’re invited to an event that
doesn’t immediately sound interesting? Politely give thanks for the invitation and offer

to get back to the person who made the request after you have checked your schedule.
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This way you can decide to decline if the event takes time away from your personal

priorities.

86) Manage extracurricular activities. What activities can you eliminate or reduce
from your schedule? Do you spend too much time in front of the television? Do you feel
compelled to read the paper from cover to cover every morning? Do you participate in
groups or associations out of habit and obligation? Try to compromise on the activities
that suck up time by reading only the sections of the paper that you really enjoy or
minimizing the number of television shows you watch. Reduce your participation in

other activities as well and use the extra time for quality rest and relaxation.

87) Keep a gift list. When inspiration strikes and you get a gift idea for someone you
know, jot it down in your spiral book. Even if their birthday or holiday is six months off,
you’ll not only save time when it comes time to do your shopping, but your gift will be
more thoughtful. Pay attention when spending time with family and friends and notice
when they comment on that sweater they’ve been wanting or how much they love the

vase in your living room.

88) Shop year round. Save last minute gift-buying hassles by picking up gifts when
you see them. Many of us vow to start our holiday shopping in January and imagine how
easy your next holiday will be if you actually finish shopping by October. While the
crowds are filing into the mall in December, you can enjoy a glass of egg nog and extra

time with your family.

89) Shop Online. Do you hate facing the crowds at the mall? Or just want to save time?

Learn to shop online. Sites like http://www.Amazon.com offer everything from books

and music to home accessories and clothing. You can usually meet minimum order
requirements to earn free shipping. Some other popular shopping destinations include:

http://www.ebay.com, http://www.Buy.com and http://www.overstock.com.

90) Manage your warehouse shopping list. If you regularly visit Costco, Sams Club
or another warehouse store, keep a separate running list (in your spiral notebook) of items
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91)

92)

93)

94)

95)

96)

to buy on your next trip. Jot down when you are low on coffee, diapers or toothpaste so
you’re always prepared.

Prioritize your workouts. Schedule time in your calendar for workouts and treat

those appointments as if they were important business meetings.

Go to bed. Your productivity plummets when you are sleep deprived. It may be
tempting to stay up late to finish a project, but how far will it set you back the following
day when you’re dragging through your tasks? Stick to a schedule and get your rest.

You will not only be more productive, but your health will benefit too.

Get some exercise. It’s easy to let exercise fall down the list of priorities, but your
body needs and deserves some daily activity. If you can’t possibly find a way to
schedule in time at the gym, at least take a few short walks during the day. Even a 15-
minute walk can speed up your metabolism and give you a burst of energy. Force
yourself to take short breaks and walk around the building or the block. Take your dog
for a quick stroll a couple of times per day- you’ll both reap the benefits.

Stay out of the drive thru. When you’re in a hurry, fast food may seem like an
easy option, but that burger probably isn’t worth it in the long run. Instead, pack quick
snacks like energy shakes, yogurt, whole grain crackers and cheese. You can even pick
up a piece of fruit at most convenience stores these days. Try visiting a deli for a

sandwich or soup.

Listen to audio books. If you want to read the latest trade or business books or even
just a novel for pleasure, audio books can help you squeeze in reading time while you’re
doing other things. You can listen in your car, in a walkman while you’re at the gym or
while you cook dinner or mow the lawn. Check them out at the library or purchase from

http://www.audible.com or http://www.amazon.com.

Keep a report or book with you at all times. In line at the grocery store or post
office? Catch up on your reading! Waiting for your kid’s practice to end? Finish up a

chapter. If you’re required to do a lot of reading for work, keep some of the materials on
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hand and catch up whenever you have a few extra minutes to spare or keep a magazine or

book handy to steal a few minutes of pleasure reading.

97) Make two lists- one for things you want from life and one of things you need.
When a time sucking offer comes your way, ask yourself if it’s something that meets
your wants or your needs? If it’s purely obligation or doesn’t fit in with the priorities in
your life, keep it off your To Do list.

98) Remember the most important relationships in your life. Time passes quickly
and it’s easy to forget to watch your kids grow up, spend time with your aging parents or
touch base your best buddy. These people should be on your priority list and if you have
to, schedule in the time to spend with them—they don’t even have to know about your
schedule, but they will appreciate the effort.

99) Make time management part of your lifestyle. Experts tell us that it takes 21 days
to create a habit. Stick to your new time management strategies for just a few weeks and
you’ll soon be in a new groove. The same way that you remember to brush your teeth
and shower each morning, you can make time management strategies part of your daily

routine.

100)  Get support. Involve your coworkers, friends and family when you begin taking
your time management seriously. Let them all know about your new schedule and that
you need their support to make it work.

101)  Most important of all, don’t forget to allow time for yourself. We all need and
deserve a slice of time each day to read, take a bath, play a game or just enjoy some
peace and quiet. Make this a regular part of your routine and you will achieve balance
and harmony in all areas of your busy life.
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By now you should have plenty of ideas for making your life more efficient and manageable.
Remember to implement them slowly and avoid trying to tackle all of these suggestions like
another To Do list. The point of all this is to avoid overwhelming yourself and to begin
changing some of your habits. Soon you should see dramatic changes in your productivity and

the overall quality of your life.
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Good luck with your time management goals and may you enjoy your new found time and some
peace of mind!
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